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FmPro Migrator - FileMaker to SQL Server Migration Procedure

This document provides an explanation of the steps required to perform a FileMaker to SQL Server 

data migration project using FmPro Migrator or FmPro Migrator Developer Edition.

Documentation Conventions:

FileMaker 11+ - refers to FileMaker Pro or FileMaker Pro Advanced version 11 or higher.

FileMaker 7+ - refers to FileMaker Pro or FileMaker Pro Advanced version 7 or higher.

FileMaker 5/6 - refers to FileMaker Pro versions 5, 5.5 or 6.0

SQL Server - refers to Microsoft SQL Server 2000 - SQL Server 2019 database servers

Note: This manual does not cover the steps required to create a .NET application, LiveCode stack 

or PHP web application from the FileMaker database. These tasks are covered in other manuals. 

This manual covers only the process involved with transferring the data from FileMaker to SQL 

Server.

Revision 8

2/21/2022

[Added info regarding the use of 32-bit and 64-bit versions of FmPro Migrator, FileMaker Pro and 

the ODBC Data Source Administrator, and how to download the FileMaker ODBC Driver.]

Character Conversion Notes

It has been found that for proper character encoding, the following configuration works well:

1) Install matching platform versions (64-bit or 32-bit) of the FileMaker database and FmPro 

Migrator on Windows.

2) In the FileMaker ODBC driver, disable the Auto-Detect Language checkbox in the Advanced 

Language dialog.

3) Set the Multi-byte Text Encoding menu to UTF-8 in the Advanced Language dialog.

For SQL Server:

4) Enable the Perform Translation for Character Data checkbox on the last panel of the SQL 

Server ODBC DSN configuration.

http://www.fmpromigrator.com/services/dbtodotnet_service.html
http://www.fmpromigrator.com/services/dbtolivecode_service.html
http://www.fmpromigrator.com/services/php_conversion.html
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Pre-Migration Task - Delete Unstored Calc Fields

Prior to transferring data from a FileMaker Pro database into a SQL database is is usually 

necessary to delete all Unstored Calculation and Summary fields from the FileMaker Pro database 

tables. This step is usually necessary when transferring more than a few thousand records 

because the amount of time required for FileMaker Pro to calculate these values may cause an 

ODBC timeout, thus preventing the data from being transferred at all. This step should be 

completed before Step 2 - Get Fieldsize is run.

FmPro Migrator includes an automated field deletion feature which can help with this task. 
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Open Manage Deleted Fields Window

Once the FileMaker table definitions have been imported via the clipboard, the list of tables will be 

displayed within the Migration Process window.

1) Double-click on the table name, the Table Details window will be displayed. Click on the 

Manage Deleted Fields button near the top of the Table Details window, the Manage Deleted 

Fields window will open.

3) Click on the Mark for Deletion Button, all of the Unstored Calculation, Summary and Global 

fields in the selected table will be marked for deletion. 

Note: Global fields are also marked for deletion in order to reduce the number of fields of data to 

speed up the data transfer process. For the example table shown in this screenshot, there were 15 

fields marked for deletion. At this point, the fields have not yet been deleted, they have just been 

marked for deletion.
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Delete Fields

1) Click the Delete Fields button. FmPro Migrator will first print a list of the ALTER TABLE SQL 

commands in the Results window, then the ALTER TABLE commands will be sent directly to the 

FileMaker database thru the ODBC connection. An example of these commands is listed below.

Note: It is common for some DROP COLUMN commands to fail as a result of Outstanding 

References by other fields. In order to resolve this issue, FmPro Migrator logs the failed DROP 

COLUMN commands and then re-sends those commands to the FileMaker Pro database again, in 

reverse order during Pass #2 processing. If PASS #2 still results in DROP COLUMN command 

failures, the remaining list of undeleted fields will be listed at the end of the processing. 

Click on the Clipboard icon to copy the commands any other software for review purposes. It will 

be helpful to have these field names available when deleting the fields manually. It is necessary to 

manually delete any fields which were not deleted automatically in order to proceed with Step #2 - 

Get Fieldsize.

ALTER TABLE "tbl_Assets" DROP COLUMN "Total Cost"

ALTER TABLE "tbl_Assets" DROP COLUMN "Total Book Value"

ALTER TABLE "tbl_Assets" DROP COLUMN "Total Depreciation"

ALTER TABLE "tbl_Assets" DROP COLUMN "Template Information Global"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteLibrary"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteSortedBy"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteCategory"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteAssignedTo"
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ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteItem"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteModel"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteSerialNumber"

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteLocation"

ALTER TABLE "tbl_Assets" DROP COLUMN "SC_Full_URL_ReadWrite"

ALTER TABLE "tbl_Assets" DROP COLUMN "SC_Full_URL_ReadOnly"

ALTER TABLE "tbl_Assets" DROP COLUMN "SC_URL_Prefix"

Field 1 of 15 Processed [Pass #1].

Field 2 of 15 Processed [Pass #1].

Field 3 of 15 Processed [Pass #1].

Field 4 of 15 Processed [Pass #1].

Field 5 of 15 Processed [Pass #1].

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteLibrary"

[FileMaker][FileMaker]  (13): Outstanding references

Field 6 of 15 Processed [Pass #1].

ALTER TABLE "tbl_Assets" DROP COLUMN "HiliteSortedBy"

[FileMaker][FileMaker]  (13): Outstanding references

Field 7 of 15 Processed [Pass #1].

Field 8 of 15 Processed [Pass #1].

Field 9 of 15 Processed [Pass #1].

Field 10 of 15 Processed [Pass #1].

Field 11 of 15 Processed [Pass #1].

Field 12 of 15 Processed [Pass #1].

Field 13 of 15 Processed [Pass #1].

Field 14 of 15 Processed [Pass #1].

Field 15 of 15 Processed [Pass #1].

Field 1 of 2 Processed [Pass #2].

Field 2 of 2 Processed [Pass #2].

----------      Completed     ----------
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Adding Deleted Fields to the SQL Database [PHP & LiveCode Conversions]

After the table has been created in the SQL database, and the data transferred to the SQL 

database, the deleted columns can then be added to the SQL database table. 

Note: This step is only needed if a PHP Conversion project is being generated, in order to insure 

that the database columns referenced in the CakePHP Model files exist within the database table.

ALTER TABLE tbl_assets ADD total_cost DOUBLE NULL;

ALTER TABLE tbl_assets ADD total_book_value DOUBLE NULL;

ALTER TABLE tbl_assets ADD total_depreciation DOUBLE NULL;

ALTER TABLE tbl_assets ADD template_information_global TEXT NULL;

ALTER TABLE tbl_assets ADD hilitelibrary BLOB NULL;

ALTER TABLE tbl_assets ADD hilitesortedby TEXT NULL;

ALTER TABLE tbl_assets ADD hilitecategory BLOB NULL;

ALTER TABLE tbl_assets ADD hiliteassignedto BLOB NULL;

ALTER TABLE tbl_assets ADD hiliteitem BLOB NULL;

ALTER TABLE tbl_assets ADD hilitemodel BLOB NULL;

ALTER TABLE tbl_assets ADD hiliteserialnumber BLOB NULL;

ALTER TABLE tbl_assets ADD hilitelocation BLOB NULL;

ALTER TABLE tbl_assets ADD sc_full_url_readwrite TEXT NULL;

ALTER TABLE tbl_assets ADD sc_full_url_readonly TEXT NULL;

ALTER TABLE tbl_assets ADD sc_url_prefix TEXT NULL;

Field 1 of 15 Processed.

Field 2 of 15 Processed.

Field 3 of 15 Processed.
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Field 4 of 15 Processed.

Field 5 of 15 Processed.

Field 6 of 15 Processed.

Field 7 of 15 Processed.

Field 8 of 15 Processed.

Field 9 of 15 Processed.

Field 10 of 15 Processed.

Field 11 of 15 Processed.

Field 12 of 15 Processed.

Field 13 of 15 Processed.

Field 14 of 15 Processed.

Field 15 of 15 Processed.
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Install FileMaker ODBC Driver - Windows - FileMaker 7,8,9,10

Install FileMaker ODBC Driver

Run the DataDirect SequeLink installer, within the xDBC/ODBC Client Driver Installer folder on the 

FileMaker Pro installation CD. Follow the prompts to install the FlleMaker ODBC Driver. 

Create ODBC DSN

To create a new System ODBC DSN, open the Control Panel > Administrative Tools > Data 

Sources (ODBC) Control Panel.
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(1) Click the System DSN tab, then (2) click the Add button.

(1) Select the DataDirect 32-BIT SequeLink driver, then (2) click the Finish button.

If the DataDirect 32-BIT SequeLink driver does not appear within the list of available drivers, 

please refer to FileMaker Technical Support Knowledge Base record #357 for more details about 

the driver installation process.
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(1) Enter the Data Source Name, (2) SequeLink Server Host, (3) SequeLink Server Port, then (4) 

click on the Server Data Source button.

Set Data Source = Default

(1) Click the item named "Default", then (2) click the Ok button. Don't select the actual name of the 

database shown in the list, or you will have to change the database name for each individual 

database file which you want to use with this ODBC DSN. Selecting the Default item in the list 

insures that you will always be able to open any FileMaker database file regardless of its name, as 

long as ODBC sharing is enabled.

Note: Setting up the Server Data Source value to the "Default" value, enables multiple individual 

FileMaker Pro files to be used with the driver, without requiring a change to be made to the ODBC 

DSN parameters. However the limitation associated with this configuration is that only one 
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FileMaker Pro database file can be used at one time with the ODBC driver. Having two database 

files open at the same time confuses the ODBC driver (even if a table name is specified to the 

driver) causing none of the tables within any of the open files to be found by the ODBC driver.

Enable ODBC/JDBC Sharing within FileMaker Pro

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going 

to be used with the FileMaker ODBC driver.
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Select Sharing Parameters

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All 

Users, then (4) click the Ok button.

Test ODBC DSN

Click the Test Connect button, enter the Username/Password to connect to the FileMaker 

database file which is currently open. 
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If the test fails:

1) Verify that the FileMaker database file is open.

2) Verify that ODBC sharing is enabled for the account entered into the connection test dialog 

prompt.

3) Make sure that there aren't two different copies of FileMaker running at the same time. Both 

older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type 

of conflict occurs, close both versions of the FileMaker application, and only open the one copy 

you want to serve the database file being migrated.

4) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). 

Then test the DSN again after rebooting.

Click the Ok button to save changes and create the new System DSN.
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Install FileMaker ODBC Driver - Windows - FileMaker 11+

Install the FileMaker ODBC driver from within the xDBC folder on the installation CD or CD image 

file.

Downloading the FileMaker ODBC Driver

The FileMaker ODBC driver is also available from the Claris support website:

https://www.claris.com/resources/downloads/

On this web page, look for the item labelled: 

xDBC update for FileMaker Platform

This item will link to the page shown in this screenshot, the actual URL has a very specific 

document number, which might change - so it is best to start with the downloads page.
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32-Bit Versus 64-Bit Installations - FileMaker Pro

Starting with FileMaker Pro 19, only 64-bit versions are available for installation. Earlier versions of 

FileMaker may include both 32-bit and 64-bit versions. To find the version of FileMaker running on 

your computer:

1) Select the Help -> About FileMaker Pro Advanced menu. 2) Click the Info button as shown 

above to see the Application Architecture.

If you are running the 64-bit version of FileMaker Pro, then you want to be using the 64-bit version 

of FmPro Migrator and the 64-bit version of the ODBC Administrator to create the ODBC DSN.
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FmPro Migrator - 64bit

Both 32-bit and 64-bit versions of FmPro Migrator are available. The About screen shows which 

version you are running.
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Create ODBC DSN - Windows

To create a new System ODBC DSN, open the Control Panel > Administrative Tools > Data 

Sources (ODBC) Control Panel.
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64-bit ODBC Data Source Administrator

The 64-bit ODBC Administrator shown in this screenshot is available from the path:

%windir%\system32\odbcad32.exe

Both 32-bit and 64-bit ODBC DSNs are displayed in the ODBC Administrator, as shown in the 

Platform column of the listing. 

Running under Windows 10, it shows (64-bit) in its window title when running.
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32-bit ODBC Administrator

The 32-bit ODBC Administrator is available from the path:

%windir%\syswow64\odbcad32.exe

This screenshot is from an earlier version of Windows, which doesn't show the Platform type in the 

list of ODBC DSNs and it also doesn't show in its title whether it is running 32-bit or 64-bit.

(1) Click the System DSN tab, then (2) click the Add button.
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Select ODBC Driver - FileMaker 11 - Windows

(1) Select the FileMaker ODBC driver, then (2) click the Finish button.

ODBC Driver Configuration - FileMaker 11+ - Windows (1)

Click Next button.

Click the About button if you need to find the version number for the driver.
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ODBC Driver Configuration - FileMaker 11+ - Windows (2)

1) Enter a name for the ODBC DSN, (2) click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (3)

1) If you are using a local copy of FileMaker Pro or FileMaker Pro Advanced, then use "localhost" 

as the host name. Otherwise use the IP address or hostname of the FileMaker Advanced Server.

2) You may optionally click the "Connect to host ..." button to get a list of database files.
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3) Click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (4)

1) Enter "Default" as the database name. Or if you have multiple database files open locally or on 

the server, then select the database name from the list or enter the name of the database. Using 

the Default keyword means that you can avoid changing the setup of the ODBC DSN when using 

different database files - but it means that only one file can be open at a time.

2) Click the Advanced Language button.
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ODBC Driver Configuration - FileMaker 11 - Windows (5)

1) Uncheck the "Auto-detect language settings" button, 2) select System (WinLatin1) for the text 

encoding, 3) click the Ok button.

It has been found that for proper character encoding, the following configuration works well:

1) Install matching platform versions (64-bit or 32-bit) of the FileMaker database and FmPro 

Migrator on Windows.

2) In the FileMaker ODBC driver, disable the Auto-Detect Language checkbox in the Advanced 

Language dialog.

3) Set the Multi-byte Text Encoding menu to UTF-8 in the Advanced Language dialog.

For SQL Server:

4) Enable the Perform Translation for Character Data checkbox on the last panel of the SQL 

Server ODBC DSN configuration.
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ODBC Driver Configuration - FileMaker 11+ - Windows (6)

Click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (7)

Click the Test button.
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ODBC Driver Configuration - FileMaker 11+ - Windows (8)

1) Enter Username, 2) Password (if needed), 3) click the Ok button.

Review the test results, make corrections as necessary until the test passes.

ODBC Error Troubleshooting Steps:

1) Verify that the FileMaker database file is open.

2) Verify that ODBC sharing is enabled for the account entered in the connection test dialog 

prompt.

3) Make sure that there aren't two different copies of FileMaker running at the same time. Both 

older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type 

of conflict occurs, close both versions of the FileMaker application, and only open the one copy 

you want to serve the database file being migrated.

4) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). 

Then test the DSN again after rebooting.

ODBC Driver Configuration - FileMaker 11+ - Windows (9)

Click the Finish button.
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Install FileMaker ODBC Driver - macOS (FileMaker 7,8,910)

Copy SequeLink.bundle File to /Library/ODBC

For FileMaker 7+ Databases on macOS:

Manually copy the SequeLink.bundle file from the ODBC Client Driver folder on the FileMaker 

application CD or ESD dmg to the /Library/ODBC folder within macOS.

Note: Using the FileMaker ODBC driver with FileMaker Pro/Advanced 7+ requires the FileMaker 

database file and ODBC driver to be open locally on the same computer where FmPro Migrator is 

running. The exception to this requirement is when the database file is opened with FileMaker 

Server Advanced. 

Download & Install iODBC Driver Administrator from OpenLink Software

Download and install the iODBC Data Source Administrator, provided by OpenLinkSoftware, 

available from (www.openlinksw.com). Downloading the iODBC framework or any trial version of 

an OpenLink Software ODBC driver for macOS will provide you with the iODBC Driver Manager. 

The iODBC driver manager does not stop working after the trial software expires. The iODBC 

driver manager provides a test feature which enables you to quickly test ODBC driver connections 

after creating or updating an ODBC DSN.
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Add the Driver

Open the OpenLink ODBC Administrator application, (1) click on the ODBC Drivers tab, then (2) 

click the Add a driver button.
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Specify Name and Pathname to Driver

(1) Enter a descriptive name for the driver, this is a name which you will select when creating an 

ODBC DSN which uses the driver. (2) Enter the full pathname to the ivslk component within the 

SequeLink.bundle file.

This image shows part of the pathname to use for a FileMaker 9 ODBC driver, with the full 

pathname listed below:

/Library/ODBC/sequelink.bundle/contents/macos/ivslk20.dylib

The name of the ivslk component changes with each revision of the DataDirect SequeLink driver 

file. You can't count on it staying the same, so it is recommended that you navigate to the location 

of the SequeLink.bundle file and select Ctrl + Show Package Contents to view the contents of the 

MacOS folder.  Clicking the Browse button to the right of the Driver file name field doesn't allow the 

selection of individual components within bundle files. You always need to manually type in this 

pathname.



FmPro Migrator - FileMaker to SQL Server - 32

(3) Click the Ok button, and the driver will be added to the list of available ODBC Drivers.

If the driver doesn't get added, try to close, then reopen the ODBC Administrator program.

Add a System DSN

(1) Click the System DSN tab, then (2) click the Add button.



FmPro Migrator - FileMaker to SQL Server - 33

Choose FileMaker ODBC Driver

(1) Select the FileMaker 9 ODBC driver from the list, (2) click the Finish button.
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Enter System DSN Parameters

(1) Enter the name of the DSN, this name must match the name shown within FmPro Migrator for 

the FileMaker Pro database. (2) Enter the Port, (3) Host, (4) ServerDataSource and (5) 

ServerDataName. Each Keyword and Value needs entered manually in the Keyword and Value 

fields. (6) After entering each Keyword/Value pair, click the Add button and the values will appear 

in the list of Keyword/Value pairs.

(7) Click the Ok button to create the System DSN.

Note: Setting up the ServerDataSource and ServerDataName values with "Default" values, 

enables multiple individual FileMaker Pro files to be used with the driver, without requiring a 

change to be made to the ODBC DSN parameters. However the limitation associated with this 

configuration is that only one FileMaker Pro database file can be used at one time with the ODBC 

driver. Having two database files open at the same time confuses the ODBC driver (even if a table 

name is specified to the driver) causing none of the tables within any of the open files to be found 

by the ODBC driver.
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Enable ODBC/JDBC Sharing within FileMaker Pro

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going 

to be used with the FileMaker ODBC driver.
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Select Sharing Parameters

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All 

Users, then (4) click the Ok button.

Test ODBC DSN

(1) Click the System DSN which has just been created, (2) click the Test button.
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Enter the (1) Username, (2) Password, then (3) click the Ok button to test the ODBC DSN.

If the test passes, this dialog will be displayed, showing that the ODBC Driver Manger has used 

this ODBC DSN to successfully connect to the FileMaker database.

If the test fails:

1) Re-verify the pathname to the svlk file within the SequeLink.bundle file.

2) Verify that the FileMaker database file is open.

3) Verify that ODBC sharing is enabled for the account entered in the connection test dialog 

prompt.

4) Make sure that there aren't two different copies of FileMaker running at the same time. Both 

older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type 

of conflict occurs, close both versions of the FileMaker application, and only open the one copy 

you want to serve the database file being migrated.

5) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). 

Then test the DSN again after rebooting.
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Install FileMaker ODBC Driver - macOS (FileMaker 11+)

Download ODBC Manager

Download and install the free ODBC Administrator for macOS from www.odbcmanager.net

You will use the ODBC Administrator to create and manage your ODBC DSNs on macOS.

http://www.odbcmanager.net
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Install the FileMaker ODBC Driver

(1) Open the xDBC folder on the FileMaker install CD (or installer image DMG file).

(2) Double-click the FileMaker ODBC.mpkg installer to install the FileMaker ODBC driver. Follow 

the insular prompts.
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Add a System DSN

(1) Click the System DSN tab, then (2) click the Add button.

Choose the FileMaker ODBC Driver

(1) Select the FileMaker ODBC driver from the list, (2) click the Ok button.
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FileMaker ODBC DSN Configuration - Page 1

Click the Continue button.
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FileMaker ODBC DSN Configuration - Page 2

(1) Enter a name for the FileMaker ODBC DSN. The name used here needs to be exactly the same 

as the ODBC DSN Name you enter into FmPro Migrator. 

(2) Click the Continue button.

Note: You can pick a different name than you see here, just make sure that you enter exactly the 

same name into FmPro Migrator.
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FileMaker ODBC DSN Configuration - ODBC DSN Field in FmPro Migrator

In this screenshot, the FileMaker 11 database is the destination database, therefore the FileMaker 

ODBC DSN name is entered in the Destination Database ODBC DSN field.

If the FileMaker database was the source database, and the data was being copied to a different 

database server, then the FileMaker ODBC DSN would be entered into the ODBC DSN field for 

the Source Database (not shown in this screenshot).
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FileMaker ODBC DSN Configuration - Page 3

(1) Enter the hostname for the FileMaker database (default is localhost).

(2) Click the Continue button.

For a file which has been opened on your local desktop machine, leave the default setting of 

localhost.

For a hosted file hosted by FileMaker Server Advanced, enter the IP Address or hostname of the 

FileMaker Server Advanced computer.
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FileMaker ODBC DSN Configuration - Page 4

(1) For most locally hosted database files, enter the text "Default" into the Database field, instead of 

selecting a database from the list. This way you can use any single database file without 

re-selecting the database name each time you open a new file. 

To use this feature, you must only have one FileMaker database file open at a time, or an error will 

occur when attempting to read info from the database.

(2) Click the Advanced Language button.
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FileMaker ODBC DSN Configuration - Page 5

(1) Un-check the Auto-detect language settings checkbox.

(2) Select UTF-8 from the Multi-byte text encoding menu.

(3) Click the Ok button.
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FileMaker ODBC DSN Configuration - Page 4

(1) Click the Continue button.
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FileMaker ODBC DSN Configuration - Page 5

(1) Click the Test button.

If the test fails, use the following steps to enable ODBC sharing for the FileMaker database. 

Note: Each FileMaker database needs to have ODBC sharing enabled individually.

FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

Enter the (1) Username, (2) Password, then (3) click the Ok button to test the ODBC DSN.
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FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

(1) Click the Ok button.

If the test passes, this dialog will be displayed, showing that the ODBC Driver Manger has used 

this ODBC DSN to successfully connect to the FileMaker database.

If the test fails:

1) Verify that the FileMaker database file is open.

2) Verify that FileMaker ODBC sharing is enabled for the account entered in the connection test 

dialog prompt.

4) Make sure that there aren't two different copies of FileMaker running at the same time. Both 

older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type 

of conflict occurs, close both versions of the FileMaker application, and only open the one copy 

you want to serve the database file being migrated.

5) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog). 

Then test the DSN again after rebooting.
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FileMaker ODBC DSN Configuration - Page 5

(1) Click the Done button to save the new ODBC DSN.
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Enable ODBC/JDBC Sharing within FileMaker Pro

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going 

to be used with the FileMaker ODBC driver.
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Select Sharing Parameters

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All 

Users, then (4) click the Ok button.
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Create SQL Server ODBC DSN

Open 32-bit ODBC Administrator

On 64-bit versions of Windows, use the 32bit ODBC Administrator when using FileMaker Pro or 

FileMaker Pro Advanced as your data source.

SQL Server ODBC DSN Setup [1]

(1) Enter a name for the SQL Server ODBC DSN, (2) select the server, (3) Click the Next button.
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SQL Server ODBC DSN Setup [2]

(1) Enter username, (2) password login info to connect to the SQL Server database [or 

alternatively use integrated Windows Authentication.

Note: The SQL Server ODBC DSN can use either Windows authentication or username/password 

authentication. However FmPro Migrator can only use username/password authentication to 

communicate with the SQL Server database.
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SQL Server ODBC DSN Setup [3]

(1) Select the default database, (2) click the Next button.
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SQL Server ODBC DSN Setup [4]

(1) Select Perform translation for character data, (2) click the Finish button.
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Step 1 - Get Info - SQL Server

At this point in the process, the FileMaker ODBC Driver should already be installed and a system 

DSN should have already been created. Please see earlier sections of this manual for more 

details.

     Step 1 - Install FileMaker ODBC Driver

FmPro Migrator uses the FileMaker ODBC driver provided by FileMaker Inc. to transfer data from 

FileMaker databases. 

For FileMaker 5/6 Databases on Windows:

The FileMaker ODBC driver is installed automatically when the FileMaker application is installed. 

This driver is installed with the Demo and Full versions of the FileMaker application. If you are 

converting FileMaker 2, 3 or 4 database files, upgrade these files into FileMaker 5/6 files in order 

to perform the migration.

For FileMaker 7+ Databases on Windows:

Install the DataDirect SequeLink driver using the installer located in the xDBC folder on the 

FileMaker application CD. Do not download and install the DataDirect SequeLink driver from the 

Datadirect website. The FileMaker ODBC driver is only supplied on the FileMaker installation CD 

or the FileMaker ESD (downloadable CD image) with the fully licensed versions of FileMaker Pro, 

FileMaker Developer 7, FileMaker Advanced and FileMaker Server Advanced.

For FileMaker 11 databases on Windows use the ODBC Client Driver Installer  within the xDBC 

folder.

For FileMaker 2, 3, 4, 5, 6 Databases on MacOS X:

Upgrade these database files to FileMaker 7+, use the FileMaker 7+ ODBC driver on MacOS X.

For FileMaker 7+ Databases on MacOS X:

Manually copy the SequeLink.bundle file from the ODBC Client Driver folder on the FileMaker 

application CD or ESD dmg to the /Library/ODBC folder within MacOS X.

For FileMaker 11 databases on MacOS X double-click the file named FileMaker ODBC.mpkg 

within the xDBC/ODBC Client Driver Installer folder. Install the ODBC Manager app from the 

www.odbcmanager.net website.

Note: Using the FileMaker ODBC driver with FileMaker Pro/Advanced 7+ requires the FileMaker 

database file and ODBC driver to be open locally on the same computer where FmPro Migrator is 

running. The exception to this guideline is when the database file is opened with FileMaker Server 

Advanced. 

http://www.odbcmanager.net
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     Step 1 - Get Info - Select FileMaker tab

Launch FmPro Migrator, then click on the FileMaker tab at the top of the window.

     Step 1 - Get Info - Select Output Directory

FmPro Migrator stores migration process information within a SQLite database file named 

MigrationProcess.db3. This file contains the metadata for the source database file(s), including 

tables, fields, table creation SQL code and status info. Therefore the first step in the migration 
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process is to select the Browse button to select the output folder FmPro Migrator will use when 

creating the MigrationProcess.db3 file.

Continue Migration...

Tip: To restart an existing migration project, select the output directory, then select Continue 

Migration... from the File menu.

Click the yellow Continue button to open the Migration Process window.

     Step 1 - Get Info - Enter Source Database Info

Select the type of source database from the Source Database menu.

Note: Since there isn't a MacOS X compatible FileMaker ODBC driver for FileMaker 5/6, these 

older database files should be converted to FileMaker 7 or higher in order to perform the migration 

on MacOS X.

Either use the existing ODBC DSN name "example_fmp_dsn" or change this name to reflect the 

name of a System ODBC DSN you have created on your computer.
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Enter the Username and Password required to access the source database file. If a password has 

not been configured within a FileMaker 7+ file, set the username to "Admin" with the password 

field empty. The user account entered here needs to have full access to the database file and 

needs to have ODBC access privileges within the file. This is the default access for the Admin 

account.

     Step 1 - Get Info - Enter Destination Database Info

(1) Select SQL Server as the destination database type. Once the destination database has been 

selected, a new set of fields will become visible for entering the connection parameters for the 

destination database.

The destination database may located either locally or remotely. (2) Enter the hostname or IP 

address for the database server, (3) TCP/IP Port number, (4) database name, (5) username, (6) 

password. Windows authentication is not supported for the SQL Server database connection - see 

Note3 below for info about creating a login account and schema and assigning privileges.

Note1: It is not generally necessary to enter/change the TCP/IP Port number for SQL Server 

databases since the connection to the database is an ODBC connection.

Note2: Make sure that the SQL Server database account entered in field (5) has full access to the 

SQL Server database. This account should have all privileges granted in order for FmPro Migrator 

to be able to create/drop tables and insert data. 
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Note3: Create a SQL Server login account, SQL Server user account and then create a schema for 

the SQL Server database. Each of these accounts can have the same name. Make sure that login 

user is assigned as the owner of the schema.

     Step 1 - Get Info

FmPro Migrator needs to get info about tables, fields, field types and repeating fields status within 

the source FileMaker database file(s). This info is used to create the tables/fields within the 

destination database and is used to copy data between the databases.

There are multiple ways which FmPro Migrator can use to get info about the source database file, 

as listed below. Use the method which works best for your computer OS and the version of the 

FileMaker database file being migrated. 

Select the pop-up menu below the Step 1 Get Info icon to select the method you want to use to get 

info from the source database file(s).  This pop-up menu is context-sensitive, based upon the 

selected source database type and the platform where FmPro Migrator is running (MacOS X or 

Windows).

     Step 1 - Get Info - Using Drag & Drop - macOS & Windows

FmPro Migrator reads the metadata directly from older FileMaker database files, including 

FileMaker 2, 3, 4, 5 and 6 on MacOS X and Windows. This method of getting info from FileMaker 

provides a very accurate representation of the source database file, including calculation formula 

definitions and repeating field counts for each field. 

1) Rename the original source file(s) to remove any spaces or special characters. This filename 

will be used as a table name within SQL statements used by FmPro Migrator to retrieve data, and 
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the FileMaker 5/6 ODBC driver does not allow spaces within table names. Spaces can be 

replaced with underscore characters to make the name easier to read. It is not necessary to 

replace characters within most filenames, as FmPro Migrator handles this task automatically when 

creating the SQL code which creates the destination table.

2) Delete all scripts, relationships and file references from the source file(s). Deleting the scripts, 

relationships and file references reduces the number of dependencies within the file and makes it 

easier to delete any fields which need removed from the table.

Select File > Define Fields... menu to open the Define Fields window within FileMaker. Delete all 

fields which are defined as Unstored Calculation, Summary or Global type fields. If these types of 

fields remain within the database file during the migration, it is likely that the ODBC driver will time 

out before retrieving the data from the source database. 

2) Create an empty copy of the source database file by selecting Save a Copy As... from the File 

menu, and selecting "clone (no records)" from the save dialog. Change the name of the saved file 

to exactly match the name of the original file.

3) Drag & Drop the empty copy of the source database file onto the Step 1 Get Info icon.

4) Repeat these steps for each source database file which needs migrated.

Note: Since there is no FileMaker ODBC driver available for older versions of FileMaker on MacOS 

X, if you use this method to get info from your source database file(s), you will will then need to 

upgrade the file(s) to FileMaker 7+ prior to performing the migration. You will then need to change 

the source database type from FileMaker 5/6 to FileMaker 7+ within FmPro Migrator.

     Step 1 - Get Info - Using ClipBoard XML - macOS & Windows

The most desirable method for obtaining info about FileMaker 7+ database files on macOS and 

Windows is thru copying the table structure using FileMaker Advanced (version 8+). This method 

copies the table creation XML code from the clipboard and includes all of the info required to 
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create the tables, fields, repeating field count and calculation formulas.

Open the FileMaker database file.

Select Define/Manage Database from the File menu within FileMaker.

(1) Select all of the tables on the Tables tab, (2) click the Copy button.

Once the Table XML info has been put onto the ClipBoard, the Paste button will become active. 

Click the Cancel or Ok buttons to close the Define dialog.
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Within FmPro Migrator, click the Step 1 Get Info button (with the ClipBoard XML menu option 

selected). The yellow Continue... button will become visible once FmPro Migrator has completed 

processing the Table XML from the ClipBoard.

Note1: In order for the ODBC driver to find each table within the source database file, there must 

be a TO on the relationship graph which exactly matches the name of the base table within the 

FileMaker database file. It is generally easier to delete all of the TOs and relationships from the 

relationship graph. Then create new TOs consisting of only the base table name. Otherwise, the 

ODBC driver will not be able to find and transfer data from each table within the FileMaker 

database.

Note2: If you want to transfer relationships to the destination database, use FileMaker Advanced to 

export a DDR from the original FileMaker 7+ file before removing the TOs. Then import the 

relationships from the DDR later in the migration process, so that SQL code can be created to 

represent these relationships within the destination database.

Note3: It is not necessary to replace spaces within FileMaker 7+ table names, as was necessary 

for FileMaker 5/6 files. It is necessary to replace high ASCII characters (greater than ASCII 

character code 127) and Unicode characters within table and field names, as these characters are 

not supported by the FileMaker ODBC driver.
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Click the Step 1 Get Info button. The table structure info will be read from the source database file, 

and written into a newly created MigrationProcess.db3 file. The yellow continue button will then 

become visible.

Note1: In order for the ODBC driver to find each table within the source database file, there must 

be a TO on the relationship graph which exactly matches the name of the base table within the 

FileMaker database file. It is generally easier to delete all of the TOs and relationships from the 

relationship graph prior to gathering info via ODBC. Then create new TOs consisting of only the 

base table name. Otherwise, the ODBC driver will report each TO (including self-joins) as a 

separate base table within the FileMaker database. So you will end up trying to migrate the same 

data multiple times, just based upon the TOs on the relationships graph - which is not required. For 

migration purposes, you only need to migrate the data from the base tables.

Note2: If you want to transfer relationships to the destination database, use FileMaker Advanced to 

export a DDR from the original FileMaker 7+ file before removing the TOs. Then import the 

relationships from the DDR later in the migration process, so that SQL code can be created to 

represent these relationships within the destination database.

Note3: It is not necessary to replace spaces within FileMaker 7+ table names, as was necessary 

for FileMaker 5/6 files. It is necessary to replace high ASCII characters (greater than ASCII 

character code 127) and Unicode characters within table and field names, as these characters are 

not supported by the FileMaker ODBC driver.
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     Step 1 - Get Info - Click Continue... Button

FmPro Migrator will make the yellow Continue... button visible once it has gathered info from the 

FileMaker database. Click this button to open the Migration Process window and continue on to 

Step 2 of the migration process.
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Step 2 - Get Fieldsize

FmPro Migrator needs to determine the maximum amount of data stored within each field of the 

source database table. To accomplish this task, FmPro Migrator performs a SELECT query to read 

all of the records from the source FileMaker database table. Before FmPro Migrator can make a 

successful ODBC connection to the source database, a System ODBC DSN needs to be created.

At this point in the process, the FileMaker ODBC driver should already be installed on either 

MacOS X or Windows.

     Step 2 - Get Fieldsize

(1) Click on a table in the Tables list. Once a table is selected, a list of fields contained within the 

table will be displayed in the Fields list. These fields represent the info gathered from the source 

database by FmPro Migrator. 

(2) Clicking the Table Details button opens the Table Details window, which enables you to view 
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and make changes to the individual parameters for the table.

(3) The Field Details button provides you with the ability to view and make changes at the field 

level.

Click the Step 2 Get Fieldsize button. FmPro Migrator will make an ODBC connection to the source 

FileMaker database, and put up a progress dialog as it is reading thru the records. After the 

records have been successfully read from the table, the status menu at the bottom of the Step 2 

button will change from "Not Started" to "Completed".  The status will be set to "Failed" if the Get 

Fieldsize step fails for some reason.

If the Get Fieldsize step fails:

1) Check to make sure that the source database is open within FileMaker Pro/Advanced on the 

local computer.

2) Make sure that ODBC sharing is enabled.

3) For FileMaker 7+ databases, make sure that there is a TO on the RelationshipGraph which 
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exactly matches the name of the base table being queried by FmPro Migrator.

4) Open the Define/Manage Database dialog and verify the existence of the base table within the 

FileMaker database.
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Step 3 - Create SQL Server Database

Before transferring data into SQL Server, it will be necessary to have a SQL Server database 

available to store the data. This section of the manual shows how to create the database, login 

user, database user and schema within the SQL Server database. These screenshots show the 

process being done with Navicat software, so they will look at little different compared to using 

Microsoft SQL Server Management Studio software.

Create SQL Server Database

A database user named user1 has already been created, so it is being used in this example as the 

database owner. But the sa account could also be used.

The Collation has been set as Latin1_General_100_CI_AS_SC for Unicode support. Other 

collations could be used in order to support the specific character encoding of the local computer 

which is transferring the data. Database tables will be created using NVARCHAR column types by 

FmPro Migrator for storing Unicode characters. All data within FileMaker database files is natively 

stored as UTF8 data.
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Create SQL Server Login User

Selecting the button User-> Login User creates the new login user within the database. (1) This is 

the user account and (2) password which will be used by FmPro Migrator to log into the database, 

create/drop tables, insert data into the new tables.

(3) The Enforce Password Policy has been disabled, because FmPro Migrator isn't going to be 

able to log into the account to change the password upon first login. For production usage, after 

the data has been transferred, this option should probably be enabled. (4) The newly created 

database is selected as the default database, though FmPro Migrator does specify the database 

name each time it connects.
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Create SQL Server Database User

Create a SQL Server database user to match the login user just created. (1) The username is the 

same as the login, (2) the user type is "For Login", the login name is the same as the previously 

created login (which will appear in the list of available logins). (4) The Default Schema is left at 

<default> for now, since it doesn't yet exist.
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Setting Roles & Permissions

For the purposes of the data transfer, the Roles & Permissions for the login user account are set as 

follows. These should be changed as necessary after completion of the data transfer in order to 

match existing IT user policies.

Roles:

serveradmin

sysadmin

Server Permissions:

ALTER ANY LOGIN

ALTER SETTINGS

CONTROL SERVER

CONNECT SQL

Click the Save button to save these changes.
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SQL Server Database User Roles & Permissions

For the purposes of the data transfer, the Roles & Permissions for the database user account are 

set as follows. These should be changed as necessary after completion of the data transfer in 

order to match existing IT user policies.

Roles:

db_datareader

db_datawriter

db_owner

Owned Schemas:

<Not configured>

Database Permissions:

ALTER

ALTER ANY SCHEMA

BACKUP DATABASE

CONNECT

CONTROL

CREATE FUNCTION

CREATE PROCEDURE

Click the Save button to save these changes.
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Create User Schema [Ok to Skip]

Note: It is no longer necessary to create a database schema for the new database user - because 

FmPro Migrator now uses DBO as the default schema name when creating tables.
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Step 3 - Create Table

Once the Get Fieldsize step has been completed, FmPro Migrator has enough information to 

create the SQL code defining the table in the destination database. The fieldsize info is 

automatically used when creating the table in the SQL database.

Note1:  If you are using FmPro Migrator 8.01 or higher, FmPro Migrator will automatically write the 

tables into the dbo schema for SQL Server, and directly to the table without a schema designation 

for other databases.

     Step 3 - Create Table

Click the Step 3 Create Table button to create the table in the destination database.

FmPro Migrator will generate the table creation SQL code, connect to the destination database 
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and create the table. Once the table has been successfully created, the status menu under the 

Step 3 Create Table button will be changed to "Completed".

Holding down the shift key while clicking the Step 3 Create Table button drops and re-creates the 

table in the destination database. 

Warning: Dropping the table in the destination database causes the loss of all data within the 

table.

     Step 3 - Table Creation SQL Details

if problems occur while creating the table in the destination database, you can review the table 

creation SQL code generated by FmPro Migrator by clicking the Table Creation Details button, 

next to the Step 3 Create Table icon.
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     Step 3 - Create Table - Table Creation Details Window

From within the Table Creation Details window, the Table Creation SQL code can be (1) manually 

edited, (2) saved or (3) re-executed in the destination database. The table can also be (4) dropped 

in the destination database.

The Post Table Creation SQL code can also be (5) manually edited, (6) executed, and (7) saved.

Clicking the (8) refresh button re-loads the previously stored version of the SQL code from the 

SQLite database.
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Step 4 - Transfer Data

Step 4 - Transfer Data - Unicode Characters

As of FmPro Migrator 7.58, NVARCHAR/NVARCHAR(MAX) columns are created within SQL 

Server databases. 

As of FmPro Migrator 9.37, FmPro Migrator always uses the SQL_WVARCHAR binding within the 

Perl script to insure proper UTF-8 encoding of the data for Access databases.

In general you should always select UTF-8 in the Advanced Language Options section of the 

FileMaker ODBC Driver 11+ versions.

Note: For most databases, it is no longer necessary to hold down the Shift key when clicking the 

Transfer Data step for full Unicode compatibility. For Microsoft Access and SQL Server databases, 

FmPro Migrator always performs this task for you automatically, as indicated by a small command 

prompt window showing the data transfer in progress. Nothing is actually displayed in this window 

presently. If you wanted to see the data transfer in progress, you could use the command prompt 

on Windows to run the xferData.EXE application which then runs the xferData.pl script.

DSN Configuration Note: Since the xferData.EXE app is used for transferring data to Access 

databases, the ODBC DSN for the Access database will need to be configured to point to the 

Access2016.accdb file. The automatically generated file DSN is only used for creating the table in 

the Access database. So if you can create the table, but not transfer the data - the ODBC DSN 

configured in FmPro Migrator probably needs updated to use the Access2016.accdb database file.
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Step 4 - Transfer Data

Click the Step 4 Transfer Data button to transfer data from the source table in the FileMaker 

database to the newly created table in the destination database. Once the data has been 

transferred successfully, the status menu below the Step 4 Transfer Data button will change from 

"Not Started" to "Completed".
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     Step 4 - Transfer Data - Troubleshooting

If the data transfer process fails, an error message will be displayed containing the text of the error 

message returned by the destination database. 

Some of the most common data transfer errors include:

FileMaker numeric fields containing non-numeric data.

FileMaker date fields containing non-date/time data.

FileMaker primary key fields containing duplicate or empty values.
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     Step 4 - Transfer Data - Troubleshooting - Non-Numeric Data Type Error

The FileMaker application is very forgiving of the types of data which can be entered into each 

field. Therefore it is possible for non-numeric data to be entered into numeric fields if field 

validation has not been enabled for these fields. However SQL databases generally won't accept 

non-numeric data within numeric fields, which will cause an error during the data transfer process.

If this type of error occurs:

Option 1: Correct the data within the FileMaker database in order to resolve the problem. Then 

drop and re-create the table in the destination database and click the Step 4 Transfer Data button 

again.

Option 2: Correct the data after transferring the data to the destination database. To get the data 

transferred to the destination database, click the Set Numeric Fields to Text button, above the 

Fields list. This button instructs FmPro Migrator to change all of the numeric field types to varchar 

field types in the table creation SQL code for the destination table. 
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     Step 4 - Transfer Data - Lock Table Details

After clicking the Numeric to Varchar, Date to Varchar or Varchar to TEXT buttons, open the Table 

Details window and click the lock icon. Setting the lock icon prevents FmPro Migrator from 

re-setting the field types back to their original values when clicking the Step 3 Create Table button.

Hold down the Shift key and click the Step 3 Create Table button to drop and re-create the table in 

the destination database, then click the Step 4 Transfer Data button again.

Note: You must generate table creation SQL code by clicking the Step 3 Create Table button at 

least once, before clicking the lock icon on the Table Details window.
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     Step 4 - Transfer Data - Troubleshooting - Non-Date/Time Data Type Error

If data transfer errors occur as a result of having non-date/time data within Date/Time fields, 

clicking the Set Date/Time Fields to Varchar button will change these column types to varchar 

columns in the destination database.

Open the Table Details window, click the Lock icon, then hold down the Shift key while clicking the 

Step 3 Create Table button.

     Step 4 - Transfer Data - Varchar to TEXT Conversion

It is not usually necessary to change Varchar columns to TEXT column types in the destination 

database. But occasionally you might need to perform this task. If you wanted to perform a quick 

migration, without running the Get Fieldsize step, you could just convert all of the Varchar columns 

to TEXT column types without worrying about the exact size of the data being transferred. FmPro 

Migrator will utilize the correct column type in the destination database for storing the largest 

amount of text.
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After clicking the Varchar to TEXT button, open the Table Details window, click the Lock icon, then 

hold down the Shift key while clicking the Step 3 Create Table button. This process will drop and 

re-create the table in the destination database, creating the new table with the requested column 

type changes.

Step 4 - Transfer Data - Troubleshooting

Error Message: Count Error (1). 

If an unexpected error occurs during the data transfer process, there is an alternate data transfer 

process built into FmPro Migrator which can be used. Hold down the shift key when clicking on the 

Transfer Data button. The alternate data transfer method will open a separate console window and 

will run a compiled Perl program to transfer the data between databases.
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If transferring data to an Access database, create an ODBC DSN to the destination database, as 

shown in the Table Details window. Open the Table Details window by double-clicking on the 

table in the list of tables. 

Note: For some databases like SQL Server and Microsoft Access, this alternate data transfer 

method is always used, so you don't need to hold down the shift key.

Step 4 - Transfer Data Troubleshooting - SQL Server 2008 Memory Error

SQL Server 2008 may fail to insert data which will display this error message in FmPro Migrator.

Troubleshooting Tip #1:

Install the latest SQL Server Service Pack (at least SP3).

Troubleshooting Tip #2:

Try using the following commands to free up memory:

           DBCC FREESYSTEMCACHE ('ALL');

           DBCC DROPCLEANBUFFERS;

           DBCC FREEPROCCACHE;

           DBCC FREESESSIONCACHE;

Troubleshooting Tip #3:

Upgrade to SQL Server 2012 or higher. Database tables which failed to transfer to SQL Server 

2008 have successfully worked with SQL Server 2012+ versions.
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Step 5 - Convert Data (Repeating Fields)

The buttons for Steps 5, 6 and 7 will only be visible if the source FileMaker Pro database table 

contains repeating fields.

FmPro Migrator converts non-relational repeating fields data into child records referencing the 

parent table record using the primary key of the parent table. The child table is created in the 

destination database using the naming convention parent_table_repeating. Each individual 

repeating fields data value is written into a separate record within this table.

Repeating Fields Processing - Preparation Steps

In order to accurately transfer repeating fields data, FmPro Migrator needs to determine the 

Primary Key field within the source FileMaker database table. FmPro Migrator identifies the 

Primary Key field as being a field in which Unique and Not Empty data validation is configured. 

The Primary Key field contains a "1" in the PK column as shown in the field list.
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If the Primary Key field contains empty or non-unique values, then the data needs to be corrected, 

or a new Primary Key field needs to be defined. Only one field should be defined as the Primary 

Key, and this field should be defined as a numeric field, as SQL databases don't generally handle 

Auto-Incrementing of Text and Numeric values within the same field (as FileMaker easily does).

To create a new Primary Key field within the FileMaker database, create a numeric field having 

Unique and Not Empty field validation. Disable the Unique and Not Empty validation for the 

original Primary Key field. 

Select the Records > Show All Records menu item, to make sure that all records will be affected by 

the Replace Field Contents feature.

After creating the new field, put the cursor into this new field, then select the Records > Replace 

Field Contents menu item.

Repeating Fields Processing - Creating New Primary Key

Using Replace Field Contents, replaces the empty values within the new Primary Key field with an 

incrementing series of numbers, within all records of the source table.

After adding this new Primary Key field and replacing field contents, you will need to start the 

migration process over starting with Step 1, since the structure of the source table has changed 

and FmPro Migrator needs to be aware of any changes which have been made to the source table.
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Step 5 - Convert Data (Repeating Fields) - FileMaker 7+ Only

For FileMaker 7+ source database tables, Step 5 processing is designed to change the contents of 

repeating fields data so that it can be transferred thru the FileMaker 7+ ODBC driver. FileMaker 7+ 

ODBC drivers are no longer capable of transferring data from repeating fields within the FileMaker 

database. To work-around this ODBC Driver limitation, FmPro Migrator moves all of the repeating 

fields data into the first repeating data value, and separates each repeat value with a TAB data 

separator. 

When the Step 5 Convert Data (Repeating Fields) button is clicked, FmPro Migrator generates 

FileMaker Script Workspace scripts to convert the data within each repeating field data and puts 

this script onto the ClipBoard.
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Click the Ok button to the informational dialog.

Open the FileMaker Script Workspace, and paste the script from the ClipBoard into FileMaker.

Manually change each of the repeating fields from Numeric or Date/Time format to Text within 

FileMaker. It is not necessary to re-gather info from FileMaker after making this change.

Run the script shown in the dialog (the one you just pasted into the Script Workspace).

Warning: Running the RF Convert script for a particular table is a task which should be performed 

one-time only. It should not be run more than once. To verify whether the RF Convert script has 

previously been run on a table, check to see if all of the repeating field data values have been 

moved to the first repeating field occurrence within the database.

If FileMaker gets interrupted while running the script, it's generally not possible to start the process 

over again with the remaining records. For instance, the script could stop if a data validation error 

occurs with one of the other fields of the database table. If this type of problem occurs, then it will 

be necessary to get a copy of the database file, copy and run this script again after solving the 

problem.
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     Step 5 - Convert Data (Repeating Fields) - Verifying Data Conversion

This image shows the contents of a repeating field shown on the FileMaker layout as "Serial #", 

which has been successfully converted with the RF Convert ScriptMaker script. If the RF convert 

script had not been run, then there would be vertical lines separating each repeating value. But 

since all of the repeating field data values have been placed into the first repeat occurrence, these 

vertical lines are not visible.

FmPro Migrator sets the status of the Step 5 Convert Data (Repeating Fields) step to "In Progress" 

when you click the button to generate and put the script onto the ClipBoard. FmPro Migrator 

doesn't know when you have actually run the RF Convert script within the Script Workspace, so 

you should click the pop-up menu and set the status of this step to "Completed" once you have 

completed this task. Keeping the status selections updated can be helpful if you get interrupted 

while performing the migration, so that you will know which steps you have completed for each 

table to be migrated.
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Step 6 - Create Table (Repeating Fields)

Step 6 - Create Table (Repeating Fields)

Click the Step 6 Create Table (Repeating Fields) button to create the repeating fields table in the 

destination database.

FmPro Migrator will generate the table creation SQL code, connect to the destination database 

and create the table. Once the repeating fields table has been successfully created, the status 

menu under the Step 6 Create Table (Repeating Fields) button will be changed to "Completed".

Holding down the shift key while clicking the Step 6 Create Table (Repeating Fields) button drops 

and re-creates the table in the destination database. 

Warning: Dropping the table in the destination database causes the loss of all data within the 

table.
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Step 7 - Transfer Data (Repeating Fields)

Step 7 - Transfer Data (Repeating Fields)

Click the Step 7 Transfer Data (Repeating Fields) button to transfer data from the source table in 

the FileMaker database to the newly created repeating fields table in the destination database. 

Once the data has been transferred successfully, the status menu below the Step 7 Transfer Data 

(Repeating Fields) button will change from "Not Started" to "Completed".

     Step 7 - Transfer Data (Repeating Fields) - Troubleshooting

All of the same troubleshooting steps apply to transferring repeating fields data as were mentioned 

within the Step 4 instructions. But one additional consideration involves reviewing the data 

transferred into the repeating fields.

Reviewing the data validates whether the each of the steps were processed correctly. For 

instance, if only 1 repeating value was transferred to the destination table, then this could mean 
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that the RF Convert script wasn't run or the contents of the source table fields weren't converted 

into Text prior to processing. If either of these problems occur, it is a simple matter to go back and 

re-do those processing steps, drop & re-create the table in the destination database then press the 

Step 7 button to transfer the data again. 
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